Adobe Connect FAQ
These frequently asked questions cover a wide range of topics about Adobe Connect. Answers provided
describe the solutions to the questions.
Adobe Connect offers a media-rich method of collaboration and interaction that can supplement or
supplant traditional face-to-face forms of communication, like meetings and classroom time. The
video and audio features give participants access to the visual and audible cues that are so crucial
to successful collaboration. Teams can gather and work together from distant geographic locations,
presenters can reach audiences in other cities or states, and instructors can provide course material
to students anywhere. In any meeting, meeting hosts can record meetings and presentations for any
participants to review at a later time.
Connect is a useful tool for many members of the university community. It is used at no cost by
Missouri State University students, faculty and staff members to do the following:
Virtual meetings
Online class sessions
Virtual office hours, synchronous presentations
Problem-solving tutorials
Online workshops (webinars) conferences
Small group collaboration
Persons use Adobe Connect when they need to:
Conduct web meetings to share screens or applications.
Deliver online training in real time, on demand, or offline.
Facilitate webinars that capture the attention of students.
Provide virtual office hours for students to discuss topics with faculty.
Record tutorial sessions for students to watch and understand course content.
Interview a guest speaker who is situated in a far location/country.
Lead group meetings and breakout room discussions.
Share documents with distance learners and other participants.
Conduct job interviews and discuss research findings.
Based on our license agreement, only faculty are given the access to be Host for virtual meeting
rooms. Faculty will first need to contact the Alan Roland to have their user profile configured to be
Hosts in the system. All faculty requesting access must send an email to request access to Adobe
Connect.
Use the Diagnostic Testing application to check your computer for the Adobe Connect Add-ins.
This diagnostic test will ensure your computer and network connections are properly configured to
provide you with the best possible Adobe Connect meeting experience. The diagnostic test checks
for the following:
Clear connection to Adobe Connect
Bandwidth availability
Latest Adobe Connect Add-in
Click the link to start the test
Adobe Connect allows faculty the ability to conduct synchronous discussion exercises in there online
classes. This tool will allow faculty to meet 'virtually' with their students and record the session for
later viewing on Blackboard for a peer review exercise.
Connect is a useful tool for many members of the Missouri State university community. It is used by
faculty and staff members to conduct meetings, online class sessions, presentation and online
conferences, and to collaborate in small groups, among other things. Students can access virtual
meetings by logging on as a Guest into the system.
Enter as a Guest, type your full name, then click the Enter Room button.
HOST: From the Adobe Connect homepage, choose the option, Enter with your login and
password. Enter your Adobe Connect Username and Password, then click the Enter Room button.
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If you are having trouble joining a meeting try the following:
1. Enter the meeting as a Guest user by entering in your First and Last Name in the Guest
field.
2. Click the Help link on the Meeting Login page. This takes you to the Test Meeting
Connection page where you can verify that your computer meets all necessary
requirements. If you do not pass the test you will be given instructions for what you need to
do.
3. Make sure popup blocking software is not blocking your meeting window.
4. You may be using a proxy server. To resolve this in Internet Explorer, select Tools >
Internet Options > Advanced tab. Then enable the setting Use HTTP 1.1 through proxy
connections. After doing this, clear your cookies, close all browser windows and attempt to
re-enter the meeting.
Adobe Connect meetings are conducted in virtual meeting rooms. A virtual room is a URL
established by a meeting Host, which can be used repeatedly. Meeting content is displayed in pods,
which are panels that contain various types of media. Pods enable the Host or other meeting
attendees to share computer screens or files, chat, broadcast live audio and video, and take part in
other interactive online activities.
A layout is a space where pods (Share, Notes, Attendee List, Camera and Voice, Chat, Files, Web
Links, Poll and Q & A) can be inserted and sized. Adobe Connect comes configured with three
layouts called Sharing, Discussion, and Collaboration. A Host can create their own layouts using any
number of pods as needed
To create a meeting room, follow the instructions in the Create a Meeting Room instructions.
Yes, once you create a meeting room, you can use it as many times as you like. It will be available
at the assigned URL and on the Meetings tab of the Connect user interface until you choose to
delete it. You can also record multiple times in the same meeting room. Recordings will be created
with a new URL with the most recent recording at the top of the list.
Adobe Connect Meeting Room Basics
There are three main roles you can have in a meeting: Meeting Host, Presenter, and Participant.

Meeting Host
The Host can perform the following tasks:
Set up meetings, invite guests, approve guests, put rooms on hold or
end them
Add or edit layouts
Promote and demote participants to the presenter or host role
Switch to preparing mode to create or edit layouts for a different
presentation
Show media and content, share screens, broadcast audio and video,
and change the meeting room properties
Control participant audio and video broadcast
Record the meeting room and share the recordings with participants
and presenters

Presenter
The Presenter can perform the following tasks:
Show media, slides and content, and share screens
Chat, answer questions, and broadcast live audio and video

Participant
The Participant can perform the following tasks:
View and participate in a meeting

View the content being shown, hear and see the presenter's audio
and video broadcast, use text chat, take polls, and download files
If given permission, broadcast their own audio and video
If given permission, control specific Pods where access has been
granted

Other options found in meeting rooms include:
Surveys and Polls
Whiteboards that can overlay shared documents such as PDF and PowerPoint files
A Whiteboard for writing, drawing, and problem-solving
Sharing your desktop to show multiple applications such as software, websites
You can share your screen, documents, and a whiteboard
Create your own layout using only the pods you need
Create breakout rooms for groups of students to discuss their topic findings
By using Adobe Presenter (within PowerPoint), you can creates quizzes to upload to Adobe
Connect for e-Learning
To send a message to everyone, simply type your message in the chat pod and hit enter or click the
send icon.
If the meeting host has enabled private chat, you can send messages to a specific attendee or group
within the meeting.
To do this, use the Attendees pod to hover over the name of the attendee you’d like to chat with,
and select Start Private Chat. Alternatively, you can use the Pod Options menu in the top right
hand corner of the pod to select an individual or group by clicking Start Chat With. Private chat
messages show up in additional tabs to make it easy to distinguish between private and public chat.
If the host is using a Q&A pod instead of a Chat pod, then all messages are moderated and private
chat is not available.
Adobe Connect Work with Pods
Within a meeting, you can also change your status to provide feedback to the presenter and other
attendees.
To change your status, click the arrow on the Status Options dropdown list on the Application Bar
and select your desired status option.
If you select an option above the line such as Agree or Step Away, you status remains until you
choose Clear Status. If you choose an option below the line such as Speed Up or Applause, your
status automatically clears itself after a number of seconds.
When you set your status, an icon appears next to your name in the Attendees pod.
Managing Meeting Room Attendees in Adobe Connect
Breakout rooms are sub-rooms that can be created within a meeting or training session. They are
useful for splitting a large group into smaller groups that can talk or collaborate. Breakout rooms can
be used in meetings and training sessions that have 200 or fewer people. Hosts can create up to 20
breakout rooms for a single meeting or training session.
For example, if you have 20 people in a session, you could create 4 breakout rooms and move 5
attendees to each room. In the breakout rooms, the attendees can speak to each other depending
on the audio configuration. They can use the Chat pod, collaborate on a whiteboard, and share their
screens. The host can visit all of the breakout rooms to assist and answer questions.
Hosts can use the default breakout room layout or design a new layout to use specifically with
breakout rooms. Create a custom breakout room layout if you want to do preparatory work before
sending content and people to breakout rooms. Creating custom layouts can help meetings go faster
and be better organized.
The steps to do so are:
Define breakout rooms and assign members
Begin a breakout session
Visiting breakout rooms
Send a message to all attendees in breakout rooms
Communicate attendee status in breakout rooms
Conduct a poll in breakout rooms
Asking and answering questions in breakout rooms
Chatting in breakout rooms
End a breakout session
Share breakout room content in main room
Reopen closed breakout rooms
Remove breakout rooms

Yes. Adobe Connect has a Share My Screen pod which allow a Host to:
Share their screen (or allow presenters and participants to do the same)
Share documents (only PDF and PowerPoint)
Share a Whiteboard
Sharing Your Screen in Adobe Connect
Share documents
As a host or presenter, you can share the following file types from the Content library or your
computer: PPT, PPTX, Adobe PDF, SWF, FLV, JPEG, and MP3 . The Content library is available in
Adobe Connect Central.
Note: You create presentations from PowerPoint presentations using Adobe Presenter. Adobe
Connect does not support progressive-scan JPEG files.
1. Do any of the following:
In an empty Share pod, click the pop-up menu in the center, and select Share
Document.
In the upper-right corner of the Share pod, click the menu icon
, and choose
Share > Document.
2. Select one of the following:
a. Whiteboards: Displays whiteboards created for the current meeting.
b. Uploaded Files: Displays content uploaded for the current meeting.
Click Browse My Computer to upload content for the current meeting. The
document is added to the Uploaded Content folder for the meeting in Adobe
Connect Central. An administrator can move the document to the Shared Content
folder to make the document available for other meetings.
c. My Content: Displays content in your user folder in Connect Central.
d. Shared Content: Displays content in Connect Central that is available to all
account holders with the appropriate permissions.
e. User Content: Displays content in other user folders in Connect Central. To view
the content in another user’s folder, you must have View permission from that user.
3. Select the document that you want to share, and click Open.
The selected document appears in the Share pod. The document name appears in the title
bar of the pod.
If you are having trouble seeing a hosts screen, try the following:
1. Click the Full Screen button on the top of the Share pod.
2. View the full resolution by using the pod options menu in the top right hand corner of the
pod to select Change View > Zoom In.
The meeting host may ask you to use your webcam to share video. When this is the case, a button
enabling you to share your webcam will appear on the video pod.
To share your camera, make sure your web cam is plugged in and click the Share My Webcam
button. Adobe Flash may prompt you for permission. After granting permission, a webcam video
preview appears.

If you’re happy with the preview, click Start Sharing to share your video with all participants. You
can also click the webcam icon in the Application Bar to access your webcam and preferences.
Share Your Webcam in Adobe Connect
Adobe Connect supports most cameras and video cards. Adobe doesn’t maintain a list of supported
cameras and video cards because there are too many combinations to test.
To broadcast video from the Camera and Voice pod in Adobe Connect Meeting, the operating
system must have a valid camera driver. If the operating system doesn’t have a valid camera driver,
Adobe Connect cannot use the camera. Adobe Connect uses the operating system API to check for
the camera driver. Typically most cameras, including high def and professional cameras will support
this.
You can try any type of camera you have access to, as long as there is a valid webcam driver that
Flash Player (Connect Meeting Addin) can detect in the Operating System. It’s essentially the same
mechanism if you use Google’s Gmail with Video Chat. When you try to select a camera in the
dropdown in Gmail settings, it will detect the available camera/drivers. Connect is the exact same
thing.
The following webcams do not work well in the Video Pod.
Creative VF0260
Microsoft VX 3000
Osprey 230 video card

See full explanation from the Adobe Connect Support Blog.
To run Adobe Connect, you will need the latest version of Flash Player, the Adobe Connect Add-In,
and any Browser. Adobe Connect is a web-base tool, which means apart from the browser, the
Connect Add-In, and Flash player there is nothing else to install.
The following tech specs are for Adobe Connect 9.

Windows
1.4GHz Intel® Pentium® 4 or faster processor (or equivalent) for Microsoft® Windows® XP,
Windows 7 or Windows 8; 2GHz Pentium 4 or faster processor (or equivalent) for Windows
Vista®
Windows XP, Windows Vista, Windows 7, Windows 8
512MB of RAM (1GB recommended) for Windows XP, Windows 7 or Windows 8; 1GB of
RAM (2GB recommended) for Windows Vista
Microsoft Internet Explorer 7, 8, 9, 10; Mozilla Firefox; Google Chrome
Adobe® Flash® Player 10.3

Mac OS
1.83GHz Intel Core™ Duo or faster processor
512MB of RAM (1GB recommended)
Mac OS X, 10.5, 10.6, 10.7.4, 10.8
No Adobe Connect Add-in support for Mac OS X 10.5 (Leopard). Users on Leopard can
attend meetings in the browser.*
Mozilla Firefox; Apple Safari; Google Chrome
Adobe Flash Player 10.3

Linux
Ubuntu 10.04, 11.04; Red Hat Enterprise Linux 6; OpenSuSE 11.3
No Add-in support for Linux. Users on Linux can attend meetings in the browser.*
Mozilla Firefox
Adobe Flash Player 10.3

Chrome OS
No Adobe Connect Add-in*
* If an OS above is noted to not be supported by the Adobe Connect Add-in, it means that users can
still join, host, and present in meetings within the browser, but will not be able to use functionality
enabled by the Add-in, like screen sharing. For more information on this, see this Tech Note.
The maximum size of a file that can be uploaded into Adobe Connect is 100 megabytes. Any files
greater than 100 megabytes that are uploaded may fail during the upload process.
There is currently no cost to students, faculty, and staff affiliated with Missouri State University to
use Adobe Connect with its current capacity of 500 concurrent users.
For assistance with Adobe Connect, please contact alanroland@missouristate.edu or call 417-8366720 for support.
Yes. Adobe Connect meetings can be recorded and saved for playback. Since Adobe Connect
records the events rather than just static screenshots, participants or those unable to attend the
meeting can play the recording in whatever size they would like and use some of the interactive
features that a typical participant would have been able to manipulate. Adobe Connect can even be
used to pre-record lectures for later viewing by students. Multiple recordings can be made in a single
virtual meeting room. The most recent recording will be at the top of the list. All recordings have a
unique URL and are date and times stamped. Recordings can also be downloaded by the Host to
their computer for offline viewing and editing.
Tips for Recording Meetings in Adobe Connect
Yes, Adobe Connect meetings can be recorded and shared with people who do not have access to
the Adobe Connect server. Depending on the pod layout chosen, videos, audio, shared screen or
documents and the chat will be captured in the recording. Please see the topic called Download a
Recorded Meeting for directions.
Yes, Adobe Connect meetings can be recorded and shared with people who do not have access to
the Adobe Connect server. To do this, you must create an offline version of the recording, which is
saved as a single FLV file. Once you have finished creating the FLV file, you can use any internet
browser to navigate to the location of your file.
- Do the Audio Setup Wizard instructions first before trying the other solutions found below.

- Use a headset/microphone (preferably a USB mic). This has been found to be more effective than
the internal microphone/camera from the computer. This is useful for VoIP.
- Install the latest version of Flash and Connect Add-Ins. ( http://adobe.com/flashplayer)
- Check your connection speed. (Meetings>Manage My Settings>My Connection Speed).
- Optimize meeting room bandwidth. The host can do this under Meeting, then Select Meeting
Room Bandwidth. The bandwidth should be selected based on the lowest speed used by
participants.
- Do not run other applications during the meeting. Web applications such as email or chat will
compete for CPU and client bandwith to the internet. Running such applications will often prevent
Adobe Connect from being able to use your camera or microphone drivers.
- Set the multiple speakers option. If more than one participant is speaking, be sure to select the
multiple speakers option.
- Set the push-to-talk expectations. It is more effective to have participants push to talk as opposed
to having the talk button locked down. This prevents any unnecessary audio transmissions. Also
consider setting the mechanism so that the participants speaks just after the button is being pushed,
this will prevent the beginning of sentences from being cut off.
- Verify that your computer speakers are on and your computer’s volume is at an audible level.
- Check to see if the meeting host has provided teleconference information. If this is the case, you
need to dial in via telephone to hear meeting audio.

Others cannot hear me, what should I do? Or, what if I cannot hear others?
First, check your computer's microphone settings to make sure that it is not muted and that Adobe
Connect has access to the microphone. Next, check to see if the audio is being sent to headphones
or speakers, and that the appropriate one is being used. Also, be sure that an appropriate volume
level is selected.

What can I do to improve poor audio or video quality?
Besides following the suggestions above, it is best to use a wired connection over a wireless
connection.

I don't have any video or sound. What should I do?
If you are an Attendee:
- Make sure your speakers are plugged in, have power, and are set at a reasonable volume.
- Make sure your microphone and webcam are connected, and that no other web applications are
using them. Check to make sure the microphone is not muted and or turned down (check in your
computer's volume controls).
- If you can hear/see the Presenter but not yourself, its likely that the Presenter has not given you
permission to share your video/audio feed. You can check this by simply asking the Presenter or
Host in the chat Pod.
If you are a Presenter:
- Make sure your speakers are plugged in have power, and are set at a reasonable volume.
- Make sure your microphone and webcam are connected, and that other applications are not using
them
- When Connect started you were asked to give Adobe FlashPlayer access to your webcam and
microphone. If you clicked "Deny", you need to allow flash to access these resources.
- Check your Flash Settings and verify that the correct microphones and cameras are selected. They
appear as icons at the bottom of your window.
Yes. Each Adobe Connect meeting room has a unique URL which can be inserted in Blackboard
using the option, Build Content > Web Link. The Blackboard Learning Management System (LMS)
at Missouri State has been configured with the Adobe Connect Building Block allowing faculty to
choose this tool to create their Adobe Connect meeting room and post the link, all within
Blackboard. Look for the tool, Adobe Connect Pro to setup your meeting room in any content area
in Blackboard.
You can upload any of these content types: Microsoft PowerPoint slides (PPT and PPTX), video for
Flash (FLV), interactive Flash Player compatible content (SWF), audio (MP3), PDF, Adobe
Captivate® demonstrations and simulations (SWF), prerecorded Adobe Presenter courses, images
(JPG and PNG), and compressed packages (ZIP) containing valid content.

In addition, live screen sharing allows you to share any content you have on your screen regardless
of file type.
Yes, anyone can join a meeting that is configured to accept guests. This configuration is at the
meeting hosts discretion. Hosts have 3 options when configuring the meeting: numbers 2 and 3 will
allow guests to enter without a Missouri State University ID.
1. "Only registered users may enter the room (guest access is blocked)"
2. "Only registered users and accepted guests may enter the room"
3. "Anyone who has the URL for the meeting can enter the room"
For the non-Missouri State person, the host will configure the meeting to allow "Anyone who has
the URL for the meeting can enter the room".
If you are the Meeting Host, you can select the Chat pod options > Email Chat History. Participant
s will be able to copy and paste the text from the chat to a Word document.
Yes. The Adobe Connect Mobile app is available for many mobile operating systems. See the Adobe
Connect Mobile page for more information.
Adobe Help document is a great resource for using Adobe Connect. http://help.adobe.com/en_US
/connect/9.0/using/connect_9_help.pdf

For questions or comments, contact the Computer Services Help Desk
HelpDesk@MissouriState.edu
417-836-589

